Creator Training notes

Shading Example 1
This example will give you an understanding of how to create and manipulate Infinite, Local and Spot-light
light sources and instances and how they each affect the lighting and shading of your geometry.
Part 1: Create Test Database Outline
1. First create a new database (DB)
2. Select File from the main Menu and Save As, save the new DB with file name “ShadingExample.flt”
3. Drag the bottom bar of the graphics window to show the hierarchy window
4. Set the parent to g2 ( alt+ left mouse on g2 node )
5. Set Select selection modes to Group ( shift + G )
6. Create 2 new group nodes ( shift + C twice )
7. Rename the first new group to “Geometry” ( control + J )
8. Rename the second group to “Lights” ( control + J )
9. Set the parent to Geometry group node ( alt+ left mouse on geometry node )
10. Set the selection Mode to Object ( shift + O )
11. Create 2 new object nodes ( shift + C two times )
12. Name the first Object to “cube” ( control + J )
13. Name the second Object to “grid” ( control + J )
14. Save the file.
Part 2: Create test Cube
1. Set cube object as the parent ( alt + left mouse on the cube node )
2. Open the colour palette ( control + p )
3. Set the current/primary colour to white
4. Close the colour palette
5. Turn the Grid if not already on ( g )
6. Set the grid to XY plane
7. Set the grid to draw under (draw grid)
8. Set grid dimension to 1.0
9. Using the rectangle tool, create a rectangular face on the right of the grid ( about 20 x 10 )
10. Use the wall tool to extrude the new rectangle. ( shift + W ) have keep the bottom option checked
11. Set the height to around 6.0 units
12. Save the file

Part 3: Create test Grid
1. Set grid object as the parent ( alt + left mouse on the grid node )
2. Using the rectangle tool to create a square face on the left of the grid ( about 20 x 20 )
3. Make sure the new square face is selected ( shift + F, then left mouse click on the new face)
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4. Use the Cookie Cutter tool found in Modify Geometry toolbox
5. Save the file
Part 4: Create test Sphere

1. Set geometry object as the parent ( alt + left mouse on the geometry node )
2. Use the Sphere tool on the Geometry toolbox
3. Set/keep the number of sub divisions to 3
4. Using the left select a point on the grid center red line above the grid and cube shapes
5. Using the left mouse set the Point on side about 5 units is good choice
6. Rename the new object created by the sphere tool to “sphere” ( control + J )
7. Save the file.

(Image 1: Object Layout)
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Part 5: Shade the Test Geometry
1. Make sure dynamic mode is on (L), you should see an L in top left of the graphics view
2. Select the cube object ( click with left mouse )
3. Calculate the shading ( control + G), or Main Menu/Attributes/Calculate shading
4. Set shading model to “Lit”
5. Set Angular Tolerance to 89 (default)
6. Set Sampling Tolerance to 0.010 (default)
7. Click on the OK button
8. Select the grid object
9. Calculate the shading (control + G)
10. Click on the OK button
11. Select the sphere object
12. Calculate the shading (control + G)
13. Click on the OK button
14. Unselect all ( left click in graphics window)
15. Set draw mode to solid ( D )
16. Save the file

(Image 2: Default Lit Objects)
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Part 6: Edit Infinite Light Source
An in finite light source sources provides a general lighting effect of the scene, similar to the sun. Light
radiates uniformly and in parallel from an infinite distance and a particular direction. In Creator the infinite light
goes through the origin of the database (0,0,0)

1. Open the light source Palette
2. Double click first light source in the palette to open the Modify light source Attributes dialog
3. From the File Menu on the Modify Light Source dialog select the default option
4. Set the Light source type to Infinite
5. Set the name to Infinite
6. Check the “Light Activated for Modelling” check box
7. You should see something similar to the image(3) below

(Image 3: infinite)

8. Now un-check the “Light Activated for Modelling” check box, leave this OFF
9. Close the Modify light source dialog

(Image 4: No Lights)

10. You should now see something similar to the above image(4)
11. Save the file
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Part 7: Add an Infinite Light to the Database
1. Set the selection mode to “Light Source”
2. Set the parent to Lights group node ( alt+ left mouse on lights node )
3. Create a new Light node ( shift + C )
4. Select the new light node and open its attributes window ( control += )
5. Change the new lights name to Infinite
6. Index should be set to 1 ( we only have a single light defined in the palette at this stage)
7. Make sure that the enabled check box is checked ON
8. Close the light source attribute dialog

(Image 5: Infinite Light Source)

9. You should now see the geometry shaded similar to the above image(5)
10. You can use the right mouse to rotate your view around the shapes to see how they are being lit by
the light new Infinite light source node
11. Return your viewing position to something similar to that shown in the image above
12. Save the file
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Part 8: Change the Orientation of the Infinite light source
1. Double click on the Infinite Light Source node to open the Light Source Attribute dialog
2. Make sure the Light Source is enabled
3. Set the Orientation azimuth to -60

(Image 6: Infinite Orientation)

4. Set the Orientation Elevation to -160
5. You should now see the geometry shaded similar to the above image (6). This orientates the Infinite
light source to be radiating from below and left of the geometry
6. You can use the right mouse to rotate your view around the shapes to see how they are being lit by
the light new Infinite light source node
7. Return you viewing position to something similar to that shown in the image above
8. Now disable the light source by un-checking Enable option on the Light Source Attribute

(Image 7: Infinite Orientation)

9. You should now see something similar to the above image (7)
10. Save the file
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Part 9: Create a Local Light Source
Local light sources radiate light uniformly in all directions from a specified location with in the database scene,
similar to the way a light bulb will illuminate all surfaces that it shines on. The major difference is the geometry
does not occlude the radiated light from the local light source.

1. Open the “Light Source Palette”
2. From the Edit menu create a new light source
3. Double click new light source( index 2) in the palette to open the Modify light source Attributes dialog
4. Rename the Light to Local
5. Change the type to Local
6. Click on the diffuse colour and select light green from the colour well; close the colour well once you
have selected the colour.
7. Enable the “Light Activated for Modelling”, checked ON

(Image 8: Local Light)

8. You should now see something similar to the above image(8)
9. Disable the “Light Activated for Modelling”, checked OFF

(Image 9: No Lights)

10. We should now see something similar to the above image(9)
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11. Save the file

Part 10: Adding an Local Light to the Database
1. Set the selection mode to “Light Source”
2. Set the parent to Lights group node ( alt+ left mouse on lights node )
3. Create a new Light node (shift + C)

(Image 10: Local Light Source)

4. Make sure that draw light sources in On so that we can see were the light has been placed
5. We should now see something similar to the above image(10)
6. Select the new light node and open its attributes window ( control += ) Change the new lights name
to local
7. Index should be set to 2
8. Make sure that the enabled check box is checked ON
9. Save the file
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Part 11: Positioning the Local Light
1. Double click on to Local Light Source node to open the Light Source Attribute dialog
2. Make sure the Light Source ins enabled
3. Set the Z position attribute to about 5.0, we should see something similar to the image(11) below,

(Image 11: Positioned Local Light Source)

were the gridded geometry to the left is now, being lit as well
4. Set the Z position attribute to about 20.0 and the X to 15.0, we should see something similar to the
image(12) below, now we are also lighting the top of the cube

(Image 12: Positioned Local Light Source)

5. Try positioning the local light at other positions and note how the position effects the way the geometry
is lighted, also use the right mouse to rotate around the scene.
6. When you done return the viewing position back to something similar to the above images
7. On the attribute page for the Local light source node uncheck the Enable button to turn the light off

(Image 13: No Lights)

8. We should now see something similar to the above image(13)
9. Save the file
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Part 12: Create a Spot Light Source
Spot light radiates in a specified direction, effecting only those objects falling with-in the spot lights directed
cone of light. (See the Creator manuals and online help for full details)

1. Open the “Light Source Palette”
2. From the Edit menu create a new light source
3. Double click new light source( index 3) in the palette to open the Modify light source Attributes dialog
4. Rename the Light to Spot
5. Change the type to Spot
6. Click on the diffuse colour and select light red from the colour well; close the colour well once you
have selected the colour.
7. Disable the “Light Activated for Modelling”, checked Off
8. Save the file

Part 13: Adding an Spot Light to the Database
1. Set the selection mode to “Light Source”
2. Set the parent to Lights group node ( alt+ left mouse on lights node )
3. Create a new Light node ( shift + C )
4. Make sure that draw light sources in On so that we can see were the light has been placed

(Image 14: Spot Light)

5. We should now see something similar to the above image
6. Rename the new light node to Spot ( control + J )
7. Save the file
8. Select the Spot light node
9. From the Main menu/attribute select Place Light Source.
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10. Set the position to x = -14.0, y = 7.0, z = 10.0
11. Set the Direction Azimuth to -54
12. Set the Direction Elevation to -34

(Image 15: Spot Light)

13. Click on Ok button
14. We should now see something similar to the above image(15)
15. Save the file
16. Double click on to Spot Light Source node to open the Light Source Attribute dialog
17. Set the position to x = -13.0, y = 7.0, z = 9.0
18. Set the Direction Azimuth to 170
19. Set the Direction Elevation to -58
20. Open the Light Source palette
21. Double click the Spot light ( index 3)
22. Set the Cutoff Angle to 25.00

(Image 16: Spot Light Cut Off)

23. Set the Dropoff Angle to 5
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24. Close the Modify light source dialog
25. We should now see something similar to the above image(16)
26. Save the file
27. Double Click the Spot light node, to display the Light Source Attributes dialog
28. Set the position to x = -15.0, y = 0.0, z = 20.0
29. Set the Direction Azimuth to 0
30. Set the Direction Elevation to -90

(Image 17: Spot Light)

31. We should now see something similar to the above image(17)
32. Save the file

Some things to try on your own
•

Try changing the position and orientation of the spot light so the you can shine light on the
o

Sphere

o

Cube

o

Cube and Sphere

o

Cube, Sphere and grid

•

Change the shading method from Lit to Lit Gouraud

•

Enable both the Spot Light and Local light , see how that affects the brightness and colour

•

Enable all 3 lights the Spot, Local and Infinite light, see how that affects the brightness and colour

•

Change the color and see how they interact when more than one light is enabled
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